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1. How to install the Subscriber plugin from your
dashboard

1. Log in to your site as an administrator.
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2. Go to your Dashboard and find the menu on your left.

n Options
(3 CEitemd Dashboard
Home
Welcome to WordPress! Dismiss
o W sembled some links to get you started:
0 Media Get Started Next Steps More Actions

Manage widgets or menus

] K write your first blog post
stomize Your Site
[ ] + Add an About page B Turn comments on or off

or, change your theme completely K View your site = Learn more about getting started
> Appearance
& Plugins
& U At a Glance Quick Draft
& T A sPosts 3Pages Title
B sett P 1 Comment
min
o — WordPress 4.1.1 running Twenty Fifteen theme.
Activity
Save Draft
Recenly Published (]
Some Post
New World WordPress News

Ipsum Lorem

Lorem ipsum

Hello world!

Comments

Oryoucan[...]
From MrWordPress on Hello world! #
Hi, this is a comment. To delete a comment, just log in Matt: DNS Performance
and view the post's comments. There you will have
WPTavern: How to Get Your WordPress Site Ready for
Google's New Mobile-Friendly Ranking Algorithm

All | Pending Approved | Spam Trash WPTavern: HeroPress Publishes its First Essay “Finding

Your Place” by Andrey Savchenko

ular Plugin: WooCommerce - excelling eCommerce (install

WordPress.

g wit

3. Select “Plugins” => “Add New.”
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Welcome to WordPress!

we' sembled some links
Get Started
Customize Your Site

+

or, change your theme completely ]

Quick Draft
3Pages Title
¥ 1 comment

mind

WordPress 4.1.1 running Twenty Fifteen theme.

Activity

Recently Published

Some Post

New World WordPress News
peum Lorem Wordpress 4.2 Beta 2
Lorem ipsum

Hello world!

Comments

From Mr WordPress on Hello world! #
Hi,this is a comment. To delete a comment, just log in
and view the post's comments. There you will have

Next Steps
[ Write your first blog post

Add an About page

View your site

DNS Performance

More Actions

Manage widgets or menus

B3 Turn comments on or off

= Learn more about getting started

WPTavern: How to Get Your WordPress Site Ready for

Google's New Mobile-Friendly Ranking Algorithm

Al Pending(0) | Approved = Spam(2) | Trash

Your Place’

by Andrey Savchenko

WPTavern: HeroPress Publishes its First Essay “Finding

Popular Flugin: WooCommerce - excelling eCommerce (install)

4. Find the Search field.

Add New

Editor

Featured  Popular  Recommended  Faverit

Plugins extend and expand the functionality of WordPress. You may automatically install plugins from the Wordpress Plugin Directory or upload a plugin in zip format via this page.

Akismet

Install Now

Akismet checks your comments against More Details
the Akismet Web service to see ifthey

look like spam or not.

By Automattic

bbbl 222)

29,378,693 downloads

Last Updated: 1 week ago

v Compatible with your version of WordPress

Install Now

BuddyPress

BuddyPress helps you run any kind of
social network on your WordPress, with
member profiles, activity streams, user
groups, messaging and more.

More Details.

By The BuddyPress Community

ot oty (15

2,707,076 downloads

Last Updated: 1 menth ago

+ Compatible with your version of WordPress

Popular tags

You may also browse based on the most popular tags in the Plugin Directory:

admin aax pudapress COMMENtS content ecommerce email Facebook reea gallery google image images javascript [quer

+ .

[ 4

ol T (sa2)

15,183,895 downloads

L8 ¢ ¢ ¢ {C)

561,671 downloads.

Jetpack by WordPress.com

Install Now
Your WordPress, Streamlined. More Details

By Automttic

Last Updated: 7 days ago

¥ Compatible with your version of WordPress

Theme Check

Install Now

Asimple and easy way to test your theme
for all the latest WordPress standards and
practices. A great theme development
tool

More Details

By Pross, Otio42

Last Updated: 3 months ago

+ Compatible with your version of WordPress

link links  login

shortcode sidebar social spsm twitter wideo Wldget widgets woocommerce WOFdpPress youtube

th WordPress.

bestwebsoft.com
support.bestwebsoft.com

bbPress

Install Now

bbPress is forum software, made the
WordPress way.

More Details.

By The bbPress Community

b 8 8 ¢ gafiED}

1,866,202 downloads

Last Updated: 1 week ago

¥ Compatible with your version of WordPress

WP Super Cache

Install Now

Avery fast caching engine for WordPress
that produces static htm files.

More Details

By Automattic

b 8.8 8 ¢ )

6,975,388 downloads

Last Updated: 3months aga

¥ Compatible with your version of WordPress

medis PAage pages phowo proes PIUZIN POSt POSES rss seo snae
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5. Type “Subscriber” there and click “Search Plugins”.

D d Add Plugins  usload plugin
e Featured  Popular  Recommended  Favorit I Subscriber
Media
Plugins extend and expand the functionality of WordPress. You may automatically instal plugins from the WordPress Plugin Directory or upload a plugin in zip format via this page.
Akismet + . Jetpack by WordPress.com Install Now bbPress Install Now
Appearar
Akismet checks your comments against Your WordPress, Streamlined More Details bbPress s forum software, made the More Details
Plugins the Akismat Web service to see ifthey . . WordPrassway.
look like spam or not. By Automattic
; By The bbPress Community
By Automattic
Add New
TRk kolr 223 Last Updated: 1 week ago KRR RTT (543) Last Updated: 1 week ago . 2.8 8 S JiEn) Last Updated: 1 week ago
u 29,418,315 downloads + Compatible with your version of WordPress 15,201,659 downloads  Compatible with your version of WordPress 1,868,999 downloads  Compatible with your version of WordPress
e
E BuddyPress Theme Check Install Now WP Super Cache Install Now
O collapse me BuddyPress helps you run any kind of Asimple and easy way to test your theme More Details Avery fast caching engine for WordPress More Details

social network on your WordPress, with
member profiles, activity streams, user
groups, messaging, and more.

By The BuddyPress Community

for all the latest WordPress standards and
practices. A great theme development
tooll

By Pross, Ottod2

that produces static htmi files,

By Automattic

.8 8.9 ¢ fert)

6,979,273 downloads

Last Updated: 3months ago
Last Updated: 1 monthago

e e ek ok (21)

562,283 downloads

Last Updated: 3 months ago

ek kol (155)

2,708,620 downloads

v Compatible with your version of WordPress

¥ Compatible with your version of WordPress + Compatible with your version of WordPress

Popular tags

You may also browse based on the most popular tags in the Plugin Directory:

admin s pusoypress COMMENTS content ecommeree email Faceook e gallery google image iMages ascript Jquery ik linKs login media PAGE pages photo pnowes PIUZIN POSt pOStS rss seo snae
shortcode sidebar social spam twitter wvideo widget widgets woocommerce WOrdpress youtue

Version 4.1.1

kyou for cr

g with WordPress

6. You will see a list of plugins.
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SearchResults  Featured  Popular  Recommended  Favorites Keyword j Subscriber
Media
1_of33 o »
Comment
Subscriber Install Now Simple Subscribe Install Now Email Subscribers Install Now
& € = This plugin allows you to subscribe users More Detalls Simple Subscribe s the subscribe plugin More Details opiplusi Create and Send HTML newsletters to More Detalls
£ Plugins for newsletters from your website you have been watting for. It's simple to GOPIE subscribers. Also this have option to
— use, yet powerful, bulletproof and send notification email to subscribers
By BestWebSoft a
; levelopers friendly. Automa when new posts are published.
Add New By latorante, tanaylakhani By Gopi Ramasamy
b 8 % & andb) Last Updated: 2 months ago
v 23202 downloads. + Compatible with yourversion of WordPress Yook iy 77 30) Last Updated: 5 days ago &kl (15) Last Updated: 4 weeks ago
: 86,011 downloads v compatible with your version of WordPress 63,145 downloads v compatiblewith your version of WordPress
T
Settings

1.8 8 ¢ g4 {0)]

10,188 downloads

MAILMUNCH

Grow Your Email
Subscribers

b 8 8 8 ¢ (e

Effective email signup form. Install Now
+300% Email Subscribers

and Automated Newsletter

More Details

Effective email signup form integrated
with your articles and tags. Automated
newsletter based on the interests of your
readers. Analytics by News@me.

By News@me

Last Updated: 2months ago

Untested with your version of WordPress

MailMunch - Increase your Install Now
Email Subscribers by over

500%

More Details

The free and easiest way to increase your
email subscribers by over 500%.
MailMunch lets you create beautiful
optin forms for your Wordpress.

By MailMunch

Last Updated: 4 weeks ago

L85 8 ¢ HC

294,529 downloads

Yok kT (5)

9,831 downloads

Subscribe To Comments
Reloaded

Install Now

More Details
Subscribe to Comments Reloaded allows
commenters to sign up for email
notifications of subsequent replies.

By camu, reedyseth, Raam Dev

Last Updated: 1 month ago

v Compatible with your version of WordPress

Subscribe Forms Install Naw

Create Beautiful Professional looking
Subscribe Forms easily in less than 1
minute and increase your
conversions/Subscribers more than

More Details

By umarbajwa

Last Updated: 2 days ago

¥ compatiblewith your version of WordPress

4 ¢ ¢ gt

1,530 downloads

g gsgskgkdlL)

217,599 downloads.

Install Now

St Category Email Subscribe

Plugin to allow visitors to subscribe
based on category of posts

More Details

By Sanskruti Technologies

Last Updated: 1 month ago

Untested with your version of WordPress

Subscribe Button by
AddToAny

Install Now

More Details
Help visitors subscribe to your blog using

email or any feed reader, such as Feedly

My Yahoo!, AOL Reader, and many more

feed services.

By AddToAny

Last Updated: 1 yearago

Untested with your version of WordPress

7. Find the necessary plugin in the
sure you select the right plugin.

ist. Please read the description carefully to be

Datbad Add Plugins  upload piugin
Search Results Featured Popular Recommended Favorites
Mediz
<
~ Subscriber Install Now
pearance This plugin allows you to subscribe users More Details
Plugins for newsletters from your website.
By BestWebSoft
I
Add New
Editor KR K KT (5) Last Updated: 2 months ago
Ny 23,202 downloads  Compatible with your version of WordPress
T
Sett

oAk T ()

10,128 downloads

MAILMUNCH

Grow Your Email
Subscribers

L. 8.8 ¢ ({Eb]

Effective email signup form.
+300% Email Subscribers
and Automated Newsletter

Install Now

More Details

Effective email signup form integrated
with your articles and tags. Automated
newsletter based on the interests of your
readers. Analytics by News@me.

By News@me

Last Updated: 2 months ago

Untested with your version of WordPress

MailMunch - Increase your Install Now
Email Subscribers by over

500%

More Detalls

The free and easiest way to increase your
email subscribers by over 500%.
MailMunch lets you create beautiful
optin forms for your WordPress.

By MailMunch

Last Updated: 4 weeks ago

Official website;_bestwebsoft.com

Help & Support: support.bestwebsoft.com

ek &7 v (20

86,011 downloads.

o dede ol (o)

294,529 downloads

L8 8.9 {0

9,831 downloads

Simple Subscribe Install Now

Simple Subscribe is the subscribe plugin
you have been watting for. It's simple to
use, yet powerful, bulletproof and
developers friendly. Automa

More Details

Bylatorante, tanayiakhani

Last Updated: 5 days ago

v Compatible with your version of WordPress

Subscribe To Comments
Reloaded

Install Now

More Details
Subscribe to Comments Reloaded allows
commenters to sign up for e-mail
notifications of subsequent replies.

By camu, reedyseth, Raam Dev

Last Updated: 1 month ago

v Compatible with your version of WordPress

Subscribe Forms Install Now

Create Beautiful Professional looking More Details

Subscribe Forms easily inless than 1
minute and increase your
conversions/Subscribers more than

By umarbajwa

Last Updated: 2 days ago

v Compatible with your version of WordPress

gopiplus &

o e ke oz (1)

63,145 downloads

L8 8 ¢ i’

1,530 downloads

g gsgsksndlc)

217,599 downloads.

Keyword j Subscriber

1 of33 >

Email Subscribers Install Now

Create and Send HTML newsletters to More Details

subscribers. Also this have option to
send notification email to subscribers
when new posts are published.

By Gopi Ramasamy

Last Updated: 4 weeks ago

v Compatiblewith your version of WordPress

St Category Email Subscribe

Install Now

Plugin to allow visitors to subscribe More Details

based on category of posts

By Sanskruti Technologies

Last Updated: 1 month ago

Untested with your version of WordPress

Install Now

Subscribe Button by
AddToAny

More Details
Help visitors subscribe to your blog using

email or any feed reader, such as Feedly

My Yahoo!, AOL Reader, and many more

feed services.

By AddToAny

Last Updated: 1 year ago

Untested with your version of WordPress

»
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8. Click “Install Now.”

Dashboard Add Plugins  usioadpiugin
Search Results Featured Popular Recommended Favorites
Mediz
Comments
Subscriber
arance — This plugin allows you to subscribe users. More Details
Plugins o for newsletters from your website.
By BestWebSoft
I
Add New
Editar KRA KT (5) Last Updated: 2 months ago
Ny 23,202 downloads  Compatible with your version of WordPress
T

oAk T ()

10,128 downloads

MAILMUNCH

Grow Your Email
Subscribers

L. 8.8 ¢ ({Eb]

Effective email signup form. Install Now
+300% Email Subscribers

More Details
and Automated Newsletter

Effective email signup form integrated
with your articles and tags. Automated
newsletter based on the interests of your
readers. Analytics by News@me.

By News@me

Last Updated: 2 months ago

Untested with your version of WordPress

MailMunch - Increase your
Email Subscribers by over
500%

Install Now
More Detals
The free and easiest way to increase your

email subscribers by over 500%.

MailMunch lets you create beautiful
optin forms for your WordPress.

By MailMunch

Last Updated: 4 weeks ago

ek &7 v (20

86,011 downloads.

o dede ol (o)

294,529 downloads

L8 8.9 {0

9,831 downloads

Simple Subscribe Install Now

Simple Subscribe is the subscribe plugin
you have been watting for. It's simple to
use, yet powerful, bulletproof and
developers friendly. Automa

More Details

Bylatorante, tanayiakhani

Last Updated: 5 days ago

v Compatible with your version of WordPress

Subscribe To Comments
Reloaded

Install Now

More Details
Subscribe to Comments Reloaded allows
commenters to sign up for e-mail
notifications of subsequent replies.

By camu, reedyseth, Raam Dev

Last Updated: 1 month ago

v Compatible with your version of WordPress

Subscribe Forms Install Now

Create Beautiful Professional looking
Subscribe Forms easily inless than 1
minute and increase your
conversions/Subscribers more than

More Detalls

By umarbajwa

Last Updated: 2 days ago

v Compatible with your version of WordPress

gopiplus®

o e ke oz (1)

63,145 downloads

L8 8 ¢ i’

1,530 downloads

g gsgsksndlc)

217,599 downloads.

Keyword j Subscriber

1 of33 >
Email Subscribers Install Now
Create and Send HTML newsletters to More Details

subscribers. Also this have option to
send notification email to subscribers
when new posts are published.

By Gopi Ramasamy

Last Updated: 4 weeks ago

v Compatiblewith your version of WordPress

St Category Email Subscribe

Install Now

Plugin to allow visitors to subscribe
based on category of posts

More Details

By Sanskruti Technologies

Last Updated: 1 month ago

Untested with your version of WordPress

Install Now

Subscribe Button by
AddToAny

More Details
Help visitors subscribe to your blog using

email or any feed reader, such as Feedly

My Yahoo!, AOL Reader, and many more

feed services.

By AddToAny

Last Updated: 1 year ago

Untested with your version of WordPress

»

9. A popup window will ask you to confirm your wish to install the Plugin. Click “OK.”

Official website;_bestwebsoft.com

Help & Support: support.bestwebsoft.com
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Are you sure you want to install this plugin?

—

10.The resulting installation screen will list the installation as successful or note any
problems during the install.
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Help & Support: support.bestwebsoft.com


https://bestwebsoft.com/
http://bestwebsoft.com/
https://support.bestwebsoft.com/
http://support.bestwebsoft.com/

Subscriber

() CERIEEE Installing Plugin: Subscriber 1.1.9
A Po Downloading install package from https: //downloads .wordpress. org/plugin/subscriber.1.1.9. zip.
O Media Unpacking the package.
B page Installing the plugin...
® comment Successfully installed the plugin Subseriber 1.1.9.
Activate Plugin | Return to Plugin Installer

» Appearance
£ Plugins

n Plugins
Add New

ditor
& User
&
Setting
(X w

with WordPress.

11. Click “Activate Plugin.”

# Promosite B + New

() it Installing Plugin: Subscriber 1.1.9
» Downloading install package from https: //downloads .wordpress. org/plugin/subscriber.1.1.9.zip.
Q] Media Unpacking the package.
W Pag Installing the plugin...
P Commen Successfully installed the plugin Subseriber 1.1.9.
Return to Plugin Installer
» Ap nce
Plugins

n g
Add New

ditor
-
& To
Setting:
0 c w

with WordPress.

bestwebsoft.com 10 of 49
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12.Voila - Subscriber is activated! It will appear in the list of Installed Plugins.

Plugins  Addnew

.

Q] Media
. Al | Actve Search Installed Plugins
® Commen Bulk Actions J Apply

O] Plugin Description
/¥ Appearance

(1 Subscriber This plugin allows you to subscribe users on newsletter from your website.

Subscrib his plugin al bscrib letter f b

K Plugins :
K 8 Settings | Deactivate | Edit Version 1.1.9 | By BestWebSoft | View details | Settings | FAQ | Support
Installed Plugins

Plugin Description

Bulk Actions J Apply

O3 BWS Plugins

ith WordPress. Version 4.1.1

bestwebsoft.com 11 of 49
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2. How to install the Subscriber plugin from Github

1. Go to https://bestwebsoft.com/plugin/subscriber/ and click “Download

from

GitHub”

Products Services Portfolio  About

Testimonials Blog

Plugins | Subscriber (Pro and Free)

SUBSCRIBER

AT

hitpi/bestwebsoft.com’

produced by BESTWEBSOFT httpy//support.bestwebsoft.com/

In case you have any questions, or if there is an issue you want to discuss, please visit our
Support Forum.

Comments are closed.

Eleni Z said

I'm using your Subseriber plugin on my website. Everything works fine. I use It to send newsletters
to my customers.

When someone subscribes, they get the proper e-mail and everything. BUT they get a usemame

and password too. | don't have any specific area for only subscribers. They just subscribe to get the
newsletters. So how can | get rid of that?

Anna said

Hi Eleni

Unfortunatelv. this feature is not available. If vou want to remove only email notification. it is

Official website:_bestwebsoft.com
Help & Support: support.bestwebsoft.com

Contacts Support 0

$27.95"¢

With Pro license, one plugin with premium
features uniocked can be installed on a
single domain and its subdomains.

Pro

License Agreement | Support Policy

ADD TO CART

BUY NOW
Free

Help
Help Center
Documentation

Video Instructions

We recommend (0 search necessary
information In our Help Center carefully
before contacting us. All commen
questions are already listed there.

VISIT HELP

NTER

Make a Donation

Donations play an Important role in
supporting open-source projects. We
greatly appreciate any donation you can
make to help s support further
development of free products!

DONATE

Page 12 of 49
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2. You will be redirected to the page with the latest plugin version. Click “Download
ZIP”

o
G'tHub This repository Search Explore Features Enterprise Blog W sign in
bestwebsoft / subscriber-wordpress-plugin @watch 1 Hstr o YFork 1
15 commits 1 branch 0 releases 1 contributor © Code
— . ) 0
P branch: master ~ | subscriber-wordpress-plugin / + @ tssues
subsriber-wordpress-plugin v.1.1.9 11 Pull requests ©
© bestwebsoft zulnored 01 3 Feb latest comnit 31co764p71 B
4~ Puise
8 bws_menu subscriber-wordpress-plugin v.1.1.9 2 months ago
Mcss subscriber-wordpress-plugin v.1.1.9 2 months ago fai Graphs
M images subscriber-wordpress-plugin v.1.1.8 2 months ago
HTTPS clone UAL
s subscriber-wordpress-plugin v.1.1.9. 2 months ago heeps://githupcc | B
B languages subscriber-wordpress-plugin v.1.1.9 2months ago  you can clone with HTTPS or
Subversion. @
B LICENSE Initial commit ayearago
E) README.md Update README.md ayear ago
B Thumbs.db subscriber-wordpress plugin v.1.1.6 5 months ago
B readme.txt subscriber-wordpress-plugin v.1.1.9. 2 months ago
B screenshot-1.png subscriber-wordpress-plugin v.1.1.8 2 months ago
B screenshot-2.png subscriber-wordpress-plugin v.1.1.8. 2 months ago
B screenshot-3.png subscriber-wordpress-plugin v.1.1.8 2 months ago
B screenshot-4.png subscriber-wordpress-plugin v.1.1.8. 2 months ago
B screenshot-5.png subscriber-wordpress-plugin v.1.1.8. 2 months ago
B screenshot-6.png subscriber-wordpress-plugin v.1.1.8 2 months ago
B subscriber.php subscriber-wordpress-plugin v.1.1.9. 2 months ago
README.md
The Subscriber plugin is an exclusive add-on for the Sender Plugin by BestWebSoft. This plugin
allows your site visitors to subscribe for newsletters, coming from your website.

3. A popup window will suggest the place to save. Select Desktop and click “Save”:

Official website:_bestwebsoft.com Page 13 of 49
Help & Support: support.bestwebsoft.com
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GitHub This repository  Search Explore Features Enterprise Blog W sign in

-
Enter name of file to save to...
Name: ubscriber-wordpress-plugin-masteia] ]

save in folder: \j\ﬁ | @ Desktop | Create Folderl

Places Name
Q search

@ Recently Used

=

@ Desktop

= The system

|ziparchive |

| Cancel

E README.md

Subscriber WordPress Plugin

4. Make sure that the zip-file has appeared on your desktop.

Official website:_bestwebsoft.com
Help & Support: support.bestwebsoft.com
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5. Extract the Plugin folder to your desktop.

6. Read through the "readme" file thoroughly to ensure you follow the installation
instructions.

Official website:_bestwebsoft.com Page 15 of 49
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subscriber-wordpress-plugin-master
subscrib

wordpress-plugin- fiHome Desktop subscriber-word...ss-plugin-master
master

Places

© Recent
A Home css

[ Desktop 6 p— anr
D pocuments — -
& Downloads languages LICENSE readme.txt README.md

dd Music
e | | 3 |

H Videos screenshot-1.png screenshot-2.png screenshot:3.png screenshot-4.png

@ Trash o
I / i

screenshotS.png  screenshot-6.png subscriber.php Thumbs.db

contact us. PLease Note TNAT We accept requests Ln ENgLLSN Language only. ALL messages on another Languages wouldn't De accepted.

Also, emails which are reporting about plugin's bugs are accepted for investigation and fixing. Your request must contain URL of the website, issues description and WordPress admin panel access. Plugin
custonization based on your Wordpress theme is a paid service (standard price is $16, but it could be higer and depends on the complexity of requested changes). We will analize existing issue and make necessary
changes after 160% pre-payment. ALl these paid changes and modifications could be included to the next version of plugin and will be shared for all users like an integral part of the plugin. Free fixing services
will be provided for user who send translation on their native language (this should be a new translation of a certain plugin, and you can check available translations on the official plugin page).

= Installation ==

. Upload the “subscriber’ folder to the ' /wp-content/plugins/’ directory.
. Activate the plugin through the 'Plugins' menu in WordPress.
. Plugin settings are located in 'BWS Plugins', 'Subscriber'.

<a href="https://docs.google.con/document/d/1c3snoIZgS1e9AgYps19HI-CINDLACMPiqfduHStAaw/edit” target="_blank">View a Step-by-step Instruction on Subscriber Installation</a».
http://www.youtube.com/watch?v=YJOQSGXPIRY

== Frequently Asked Questions ==

= Can I create a newsletter subscriber in the backend of the sitez =

Yes. You just need to create a new user with the role of "Mail Subscriber” in Users > Add New.

= How can the user unsubscribe from the newsletter? =

1) The user should go to your site, enter his/her e-mail in the Subscribe Form, mark the "unsubscribe’ checkbocx and click the "Submit" button.

2) If everything has been done correctly, hefshe will recieve a mail with a link for unsubscription

3) If the user follows that link, he/she will be automatically unsubscribed from the newsletters.

= How can the previously registered users subscribe for the newsletter? =

The previously registered users can subscribe for the newsletter exactly as any other site visitor thru the Subscribe Form or mark the "Subscribe for newsletters” checkbox on their Profile editing page
= Why do I need the blacklist? =

If you do not want the user to receive letters of mailing for some reason, you can move him to the blacklist. Users from the black list can not receive letters and resubscribe for the mailing.

= I have some problems with the plugin's work. What Information should I provide to receive proper support? =

Please make sure that the problen hasn't been discussed yet on our forum (http://support.bestwebsoft.com). If no, please provide the following data along with your problem's description:

1. the link to the page where the problem occurs

2. the name of the plugin and its version. If you are using a pro version - your order number.

3. the version of your WordPress installation

4. copy and paste into the message your system status report. Please read more here: <a href="https://docs.google.com/document/d/14i2X8RIRGXkOKMSZQy1xItIrpNONCXgioH935MaBKEC /edit" target="_blank">Instuction on
System Status</a>

= Screenshots ==

. subscriber Settings page.

. service messages option on Subscriber Settings page.
. Letters content option on Subscriber Settings page.
. subscriber Form Registation widget settings.

. subscribe Form in frontend of site.

. subscribers list in admin panel.

QuhwN e

= Changelog ==

=V1.1.9 - 03.02.2015 =
* Bugfix : False error display when subscribing from a form was fixed.
* Bugfix : The empty "From" field in the letter to the administrator was fixed.
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7. With your FTP program upload the Subscriber folder to the
/wp-content/plugins/ folder in your Wordpress directory online.

NB: In case the name of your extracted folder differs from the name specified in the
readme file (i.e. ‘subscriber’), please change its name to that in the readme file.

plugins

< A Home wore

tent plugins
Places

© Recent :

A Home subscriber

[ Desktop

D Document ks

¥ Downloads

dd Music
@ Pictures
H videos
{@ Trash
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8. Find the plugins menu on your left and click “Installed plugins”. You will see a list
of installed plugins:

Screen Options Help
o Plugins addnew
A posts AlI(1) | Inactive (1) | Recently Active Search Installed Plugins
Q) Media Eu\kAmDnsj Apply
M P O Plugin Description
» ) Subscriber This plugin allows you to subscribe users on newsletter from your website.
Activate  Edit  Delete Version 1.1.9 | By BestWebSoft | View details
A Appearance
£ Plugins O Plugin Description
Installed Plugins Eu\kAmDnsj Apply

O B » b

Thank you for creating with WordPress. Version 4.1.1

9. Find “Subscriber” and click “Activate”.

bestwebsoft.com 18 of 49
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Subscriber

@ D rd
A r

0 Media

] .

¥ comment

» Appearance
£ Plugins

Installed Plugins

O collapse menu

Plugins  Addnew

All(1) | Inactive (1) | Recently Active
Bulk Actions Apply
Plugin
Subscriber
Edit Delete

Plugin

Bulk Actions J Apply

WordPress.

Description

This plugin allows you to subscribe users on newsletter from your website.

Version 1.1.9 | By B w detalls

Description

10. Voila! Subscriber is activated!

Search Installed Plugins

Version 4.1.1

Plugins

Installed Plugins

Plugins Addnew

Plugin activated

All() | Active

Bulk Actions -|| Apply

Plugin

Subscriber

Settings  Deactivate = Edit

Plugin

Bulk Actions

Apply

WordPress.

bestwebsoft.com

Description

This plugin allows you to subscribe users on newsletter from your website.

Version 1.1.9 | By BestWehsoft | View detalls | Settings | FAQ | Support

Description

support.bestwebsoft.com

Search Installed Plugins

19
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3. How to install the Subscriber Plugin from
wordpress.org

1. Go to http://wordpress.org/plugins/subscriber/ and click “Download version
1.1.9” (always the latest one is available)

WORDPRESS.ORG ]

Showcase Themes Plugins Mobile Support —Getlnvolved About Blog Hosting Download WordPress

Plugin Directory Username Passuord Login forgon) or Register

Developer Center produced by BESTWEBSOFT

Search Plugins

search
PopularTags  More»
pular Tag: https//bestwebsoft.com/
widget (4916) httpi//support.bestwebsoft.com/
Post (3,078)
plugin (3,022)
This plugin allows you to subseribe users for newsletters from your Download Version 1.1.9
admin (2,529) -
website.
posts (2,346)
sidebar (1,892) Desc Installation FAQ Screenshots Changelog Stats Support Reviews Developers
google (1,729)
twitter (1,680) The Subscriber plugin is an exclusiva add-on for the Sender Plugin by BestwebSoft. This Requires: 21 or higher
shortcode (1678) plugin allows your site visitors to subscribe for newsletters, coming from your website. It Compatible up to: 4.1.1

is a simple and effective tool for businessmen as well as for those people who just want to  Last Updated: 2015-2-3

(1,676)

images (1. share thelr ideas with others. Moreover, it has minimum settings but maximum feedback.  Active Installs: 5,000+
comments (1,612)

page (1,609) Ratings

image (1,505)

4.2 0ut of 5 stars

~ oo o &

Author

_ P ERan

41 plugins
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2. A popup window will suggest the place to save

. Select Desktop and click “Save”:

WORDPRESS.ORG

® @ Enter name of file to save to...

Name: fsubscriber.1.1.9Ei]}

Saveinfolder: | < ||[@ EDesktop Create Folder

Places Name

@ search
@ Recently Used

[ Desktop
= Tle System

Zip archive 2

concel,

3stars 0

2stars 0

1stars 1
Sl R

3. Make sure that the zip-file has appeared on your desktop.
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4, Extract the Plugin folder to your desktop.

subscriber.1.1.9.zip

-

subscriber
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5. Read through the "readme" file thoroughly to ensure you follow the installation
instructions.

subscriber.1.1.9.2ip

= —

-

subscriber subscriber

A Home

Places
O Recent
1 Home
[ Desktop
D Documents

< Downloads languages readme.txt screenshot-1.png screenshot-2.png
dd Music

B Pictures

Hvideos screenshot-3.png screenshot-4.png screenshot-5.png screenshot-6.png

{@ Trash B
M)

subscriber.php
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R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R R RO

contact us. Please note that we accept requests in English language only. ALL messages on another languages wouldn't be accepted

TR———

Also, emails which are reporting about plugin's bugs are accepted for investigation and fixing. Your request must contain URL of the website, issues description and WordPress admin panel access. Plugin
customization based on your Wordpress theme is a paid service (standard price is $16, but it could be higer and depends on the complexity of requested changes). We will analize existing issue and make necessary
changes after 180% pre-payment. All these pald changes and modifications could be included to the next version of plugin and will be shared for all users like an integral part of the plugin. Free fixing services
will be provided for user who send translation on their native language (this should be a new translation of a certain plugin, and you can check available translations on the official plugin page).

F= Installation ==

. Upload the “subscriber’ folder to the ' /wp-content/plugins/’ directory
b. Activate the plugin through the 'Plugins’ menu in WordPress.
. Plugin settings are located in 'BWS Plugins', 'Subscriber’'

<a href="https://docs.google.com/document/d/1c3snolZgS1e9AgY jps19HI-cIhDLACMPiqfduH5tAaw/edit” target="_blank">View a Step-by-step Instruction on Subscriber Installation</a>.
http://www.youtube.com/watch?v=Y10QSGXPIRY

== Frequently Asked Questions ==

= Can I create a newsletter subscriber in the backend of the site? =

Ves. You just need to create a new user with the role of "Mail Subscriber” in Users > Add New.

= How can the user unsubscribe from the newsletter? =

1) The user should go to your site, enter his/her e-mail in the Subscribe Form, mark the "unsubscribe’ checkbocx and click the "Submit” button.

2) If everything has been done correctly, hefshe will recieve a mail with a link for unsubscription

3) If the user follows that link, he/she will be automatically unsubscribed from the newsletters.

= How can the previously registered users subscribe for the newsletter? =

The previously registered users can subscribe for the newsletter exactly as any other site visitor thru the Subscribe Form or mark the "Subscribe for newsletters" checkbox on their Profile editing page

Why do I need the blacklist? =
If you do not want the user to receive letters of mailing for some reason, you can move him to the blacklist. Users from the black list can not receive letters and resubscribe for the mailing.
= I have some problems with the plugin's work. What Information should I provide to receive proper support? =

Please make sure that the problem hasn't been discussed yet on our forum (http://support.bestwebsoft.com). If no, please provide the following data along with your problem's description:
1. the link to the page where the problem occurs

2. the name of the plugin and its version. If you are using a pro version - your order number.
3. the versien of your WordPress installation
4. copy and paste into the message your system status report. Please read more here: <a href="https://docs.google.com/document/d/1Wi2X8RIRGXkokMSZQy1xItIrpNONCXgioH935MaBKEC /edit” target="_blank">Instuction on

System Status</a>

== Screenshots ==

"

. subscriber Settings page

2. Service messages option on Subscriber Settings page.
3. Letters content option on Subscriber Settings page
4. subscriber Form Registation widget settings.

5. subscribe Form in frontend of site.

6. subscribers list in admin panel.

== Changelog ==

=V1.1.9 - 03.02.2015 =
* Bugfix : False error display when subscribing from a form was fixed.
e MMAiu . The mmmkis NEmamil £3AT4 Sn bha Tambas b sk ~dmiadesemban oo

6. With your FTP program upload the Subscriber folder to the
/wp-content/plugins/ folder in your Wordpress directory online.
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plugins

£ plugins

O Recent

A Home

[ Desktop
D bocuments

¥ Downloads
dd Music

@ Pictures
Hvideos

@ Trash

7. Find the plugins menu on your left and click “Installed plugins”. You will see a list
of installed plugins:

e

Screen Options Help

Plugins  Addnew

Search Installed Plugins

All(1) | Inactive (1) | Recently Active (1)
iia Bulk Actions | Apply 1 item
O Plugin Description
) subscriber This plugin allows you to subscribe users on newsletter from your website.
) Activate  Edit  Delete Version 1.1.9 | By BestWebSoft | View details
£ Plug O Plugin Description
Installed Plugins Bulk Actions ~| | Apply 1item
rs
Thank you for creating with WordPress. Version 4.1.1
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8. Find “Subscriber” and click “Activate”.

& @ Promosite B + New

() it Plugins addnew

A Posts All(1) | Inactive(1) | Recently Active Search Installed Plugins

Q; Media Eu\kAmDnsj Apply

| Pay O Plugin Description

P c i O] Subscriber This plugin allows you to subscribe users on newsletter from your website.
Edit | Delete Version 1.1.9 | By BestWebsSoft | View details

» Appearance

K Plugins O Plugin Description

Installed Plugins Bulk Actions ~| | Apply

.

-

3

tin,

0

ng with WordPress. Version 4.1.1

9. Voila! Subscriber is activated!
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Plugins Addnew

’
o,

Al | Acte Search Installed Plugins
» Eu\kAmonsj Apply
0 Plugin Description
»
) subscriber This plugin allows you to subscribe u wsletter from your website
v Plu;
& Flug Settings  Deactivate  Edit Version 1.1.9 | By BestWebSoft | View details | Settings | FAQ | Support
Inst: Plugi
O Plugin Description
Bulk Actions ~| | Apply
.
-
&
1]
o )
O o

creating with WordPress.

4. Alternative way of installation

This way of installation is preferable when you download the plugin folder by using a
download link (mostly in case with Pro versions). In this case you do not have to extract the
folder with the plugin to your desktop, it will be extracted automatically in your dashboard.

1. Make sure there is the plugin’s zip-folder on your desktop.
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2. Click “Plugins" in the menu on the left in your admin area.
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Subscriber

0 Media

M Pages

L]

Plugins

Installed Plugins

We'

Get Started

Customize Your Site

or, change your theme completely

At a Glance

A sPost

® 1 comment

WordPress 4.1.1 running Twenty Fifteen theme.

Activity

Recently Published

psum Lorem

Lorem ipsum

4th, B4

Hello world!

Comments

From MrWordPress on Hello worid! #

Hi,this is a comment. To delete a comment, just log in
and view the post's comments. There you will have

Al Pending (0) | Approved = Spam(2) | Trash

Bulk Actions J Apply

Plugin
You do not appear ta have any plugins available at this time.
Plugin

Bulk Actions ~| | Apply

WordPress.

bestwebsoft.com

Next Steps
[ Write your first blog post
+ Add an About page

B2 View your site

Quick Draft

WordPress News

WPTavern: Enhanced Plugin Installs Axed From
WordPress 4.2

WPTavern: WPWeekly Episode 185 - Turning The Page
With Joshua Strebel

M

Tokyo Meetup

Description

Description

support.bestwebsoft.com

Plugin: WooCommerce - excelling eCommerce (Install)

Dismiss

More Actions

Manage widgets or menus

B3 Turn comments on or off

= Learn more about getting started
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Click “Upload.”

Add Plugins,

Featured ~ Popular  Recommended  Favorit
Media

Plugins extend and expand the functionality of WordPress. You may automatically install plugins from the WordPress Plugin Directory or upload a plugin in zip format via this page.

Akismet Install Now + . Jetpack by WordPress.com Install Now bbPress Install Now
Akismet checks your comments against More Details Your WordPress, Streamlined. More Details bbPress is forum software, made the More Details
Plugins the Akismet Web service to see ifthey Waordprassway.
By Automattic

look like spam or not.
By The bbFress Community

By Automattic

TRk kolr 223 Last Updated: 1 week ago R KR TT (541) Last Updated: 1 week ago . 2.8 8 S JiEn) Last Updated: 1 week ago

29,420,756 downloads v Compatible with your version of WordPress 15,202,535 downloads ¥ Compatible with your version of WordPress 1,869,145 downloads ¥ Compatible with your version of WordPress

BuddyPress Install Now Theme Check Install Now WP Super Cache Install Now

BuddyPress helps you run any kind of More Details Asimple and easy way to test your theme More Detalls Avery fast caching engine for WordPress More Details

social network on your WordPress, with for all the latest WordPress standards and that produces static htmi files,

member profiles, activity streams, user practices. A great theme development

groups, messaging, and more. tooll By Automatiic

By The BuddyPress Community By Pross, Otto42

.8 8.9 ¢ fert) Last Updated: 3months ago

ook W ko7 (155) Last Updated: 1 month ago ok RN K (s1) Last Updated: 3months ago 6,979,439 downloads. « Compatible with your version of WordPress
2,708,700 downloads ¥ Compatible with your version of WordPress 562316 downloads + Compatible with your version of WordPress

Popular tags

You may also browse based on the most popular tags in the Plugin Directory:

admin s pusoypress COMMENTS content ecommeree email Faceook e gallery google image iMages ascript Jquery ik linKs login media PAGE pages photo pnowes PIUZIN POSt pOStS rss seo snae
shortcode sidebar social spam twitter wvideo widget widgets woocommerce WOrdpress youtue

kyou for cr

g with WordPress Version4.1.1
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5. Click “Browse.”

> A Browse... o file selected.
M Appearance

6. A pop-up window will ask you to choose the file. Select Subscriber zip-folder and
click “Open”.
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+ New
L) [EEATE Add Plugins  srowse
» @ @ File Upload
8] Media # @ |mDesktop
]
= Places Name s size  Modified
» s Qsearch | |
@ Recently Used
2 Appearance &
£ Plugins i Desktop

L File System
"

Add New

AllFiles 2

Cancel

@ @& Promosite

@ Da: ard

g

Browse... | subscriber.1.1.9.zip

ttings

h WordPress. Version 4.1.1
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8. The resulting installation screen will list the installation as successful or note any
problems during the install.

o & L ] + New

° d Installing Plugin from uploaded file: subscriber.1.1.9.zip
Unpacking the package.

o Installing the plugin

m Successfully installed the plugin Subscriber 1.1.9.

[ ] Activate Plugin | Return to Plugin Installer

»

£ Plugins

9. Click “Activate Plugin”
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®o +N
() CERIEEE Installing Plugin from uploaded file: subscriber.1.1.9.zip
A P Unpacking the package.
O Media Installing the plugin...
LI Successfully installed the plugin Subseriber 1.1.9.

Return to Plugin Installer

¥ comme

» Appearance

£ Plugins

Add New

10. Voila! Subscriber is activated!

() CERIEEE Plugins addnew
AP
O Media
. Al | Acte Search Installed Plugins
Bulk Actions | | Apply
® comme o ey
O Plugin Description
» Appearance
") Subscriber This plugin allows you to subscribe users on newsletter from your website.
& Plugins .
& Plugi Settings | Deactivate | Edit Version 1.1.9 | By BestWebSoft | View details | Settings | FAQ | Support
Installed Plugins
. O Plugin Description
itor Bulk Actions ~| | Apply
& u
&1
Settin;

Thank you for creats WordPress.
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5. How to use the plugin

1. Find the menu on your left.
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Subscriber

Welcome to WordPress! Dlsmiss
We' sembled some links
[
Q5 Media Get Started Next Steps More Actions
B Pages [ Write your first blog post Manage widgets or menus
Customize Your Site

[} + Add an About page § Turn comments on or off

or, change your theme completely K2 View your site P& Learn more about getting started
A Appearance
& Plugins
& U At a Glance Quick Draft
& T A sPost 3Pages Title
B sett B 1 comment

n your mind?
WordPress 4.1.1 running Twenty Fifteen theme. 7
O BWs Plug
o = Activity
Save Draft
Recenty ublshed
Some Post
New World WordPress News

Ipsum Lorem WordPress 4.2 Beta 3
Lorem ipsum ilin

Hello world! -
play with
Comments rdPress B
).0ryou can
From MrWordPress on Hello world! # L.
Hi,this is a comment. To delete a comment, just log in
and view the post's comments. There you will have WPTavern: Enhanced Plugin Installs Axed From
WordPress 4.2
Al Pending(0)  Approved | Spam(2) Trash WPTavern: WPWeekly Episode 185 - Turning The Page

With Joshua Strebel
M

Tokyo Meetup

Popular Plugin: WoeCommerce - excelling eCommerce (Install)

2. Select “BWS Plugins” => "Subscriber”.
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@ Dashboard

Home

P
Media

ages

settin

BWS Pl

-
o

%
>
]
3

%

% B8
5

8
w
@
2

@ BWS Plugins

Subscriber

Dashboard

Welcome to WordPress! Dismiss

W

Get Started Next Steps More Actions

[ Write your first blog post Manage widgets or menus
Customize Your Site
+ Add an About page B3 Turn comments on or off

or, change your theme completely B View your site = Learn more about getting started
At a Glance Quick Draft

A sPost

® 1 comment

ing Twenty Fifteen theme.

Activity

Save Draft
Recenly Publshed

WordPress News

psum Lorem

Lorem ipsum

Hello world!

Comments

From Mr WordPress on Hello world! #
Hi, this Is a comment. To delete a comment, just log in
and view the post's comments. There you will have WPTavern: Enhanced Plugin Installs Axed From

WordPress 4.2

WPTavern: WPWeekly Episode 185 - Turning The Page
With Joshua Strebel

Al Pending (0) | Approved = Spam(2) | Trash

Tokyo Meetup

Plugin: WooCommerce - excelling eCommerce (Install)

settings = FAQ [T

Ifyou would like to add the Subscribe Form to your website, just copy and paste this shortcade to your post, page or widget: [sbserbr_form] or you can use Subscriber Form Registation Widget.

Subscribe form labels
E-mail

unsubscribe

Subscribe
Service messages @ | show
'FROM' field Name Emall

Promosite wordpress@bestwebsoft.c
Letters content @ show

Delete users while plugin .
removing

Add captcha to the form

Add to the subscribe form "Unsubscribe" chieckbox

Unlock premium options by upgrading to a PRO version. Learn More Go PRO

Ifyou want to send mailout to the users who have subscribed for newsletters use Sender plugin that sends mail to registered users. Thereis also a premium version of the plugin - Sender Pro, allowing to create and save templates for letters, edit the content of messages with a visual editor
TinyMce, set priority of mailing, create and manage mailing lsts.

Save Changes

Ifyou enjoy our plugin, please give t 5 stars on WordPress: Rate the plugin

Ifthere is something wrong about it, please contact us: http/support bestwebsoft.com

You for creating with WordPress,
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4. Configure the plugin the way you like.

() CERifed Subscriber Settings
2 P Settings | FAQ  [LIL)
Q7 Media

Ifyou would like to add the Subscribe Form to your website, just copy and paste this shortcode to your post, page or widget: [sbserbr_form] or you can use Subscriber Form Registation Widget.
L]
® Subscribe form labels

£-mall
» Appearance
PP unsubscribe L

¢ Plugin Subscribe L
& U
& T Service messages Q@ | sow
Settings

"FROM' field Name Emall
@ BWS Plugins Promosite wordpress@bestwebsoft.c
Subscriber
Q colia ! Letters content Q@ | sow

Delete users while plugin .

removing

Add captcha to the form

Add to the subscribe form "Unsubscribe" checkbox

Unlock premium options by upgrading to a PRO version. Learn More Go PRO

Ifyou want to send mailout to the users who have subscribed for newsletters use Sender plugin that sends mail to registered users. Thereis also a premium version of the plugin - Sender Pro, allowing to create and save templates for letters, edit the content of messages with a visual editor
TinyMce, set priority of mailing, create and manage mailing lsts.

Save Changes

Ifyou enjoy our plugin, please give it 5 stars on WordPress: Rate the plugin

Ifthere is something wrong about it, please contact us: http#/supportbestwebsoft.com

1k you for creating with WordPress. rsion 4.1.1

5. Save the changes.
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~ ard Subscriber Settings
A Settings FAQ Go PRO
% a
L
» mer Ifyau would like to add the Subscribe Form to your website, just copy and paste this shortcode to your post, page or widget: [shserbr_form] or you can use Subscriber Form Registation Widget.
» ap e Subscribe form labels T
£ Plu E-mall
o unsubscribe
-
Subscribe

&
= e Service messages @ |smow
@ BWS Plugins

'FROM' field Name Email
ST Promosite wordpress@bestwebsoft.
© coliapse men

Letters content Q@ o

Delete users while plugin .

removing

Add eaptcha to the form cboft com) Dowrload captchs

Add to the subscribe form “Unsubseribe" checkbox
unlock premium options by upgrading to a PRO version. Learn More Go PRO

Ifyou want to send mailout to the users who have subscribed for newsletters use Sender plugin that sends mail to registered users. There s also a premium version of the plugin - Sender Pro, allowing to create and save templates for letters, edit the content of messages with a visual

editor TinyMce, set priority of malling, create and manage malling lsts.

Ifyou enjoy our plugin, please give t 5 stars on WordPress: Rate the plugin

Ifthere is something wrong about it, please contact us: http/support bestwebsoft.com

6. There are two ways to display the Subscribe Form on a page or in a widget .

The first way, just copy and paste this shortcode to your page: [sbscrbr_form]. Go to the
Pages menu and click "Add New"
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Subscriber

0 @ Promoste B + New

» All(2) | Published (2) | Trash Search Pages
9 Media BulkActions  -| | Apply | Al dates || Fiker
W Pages < O Title & Author L ] Date
All Pages O Justapage admin 2015/03/20
Published

[ ] ents (] OnePage admin 2015/03/20

S Published
> A e .
& Ap e sample Page admin 2012/12/04
£l Published
- 0 Title Author [ ] Date
£ T Bulk Actions | | Apply 31tems
1]
o 1
0 «c

Version 4.1.1

7. Insert the mentioned shortcode [sbscrbr_form] into your new page and click
"Publish".
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Subscriber

() CERIEEE Add New Page

A K

Example Publish
07 Media
1 Media T vien
Change Permalinks || View Page — Previen
W Pages
o ; Status: Draft
i % Add Media e[ 7ee | | T Fa
P b || 1| unk || b-quote || et | ins || img || u || of | 1| code || more || close tags b Visibliey: Public Edit
Publish immediately Edit
[ ]
Move toTrash
A Appearance
& Plugins
L © Page Attributes
& U
7 Parent
T
settin, (no parent) J
Order
O BWs Plugin:
0
© Collapse menu
Need help? Use the Help tab in the upper
Word count: 0 Draft saved at 10:08:02 am. right of your screen
Featured Image
ured imay
Wordpress Version 4.1.1

n Options

[ rd
A P
Q] Media
W Pages Example Publish
All Pages Change Permalinks || View Page Preview Changes
]
8] Add Media — ¢ Status: Published Edit
) EoIE . Visibilty: Public Edit
b || 1 || ok || bquote || et || ins || img || u || ol || 1 || code || more || close tags b
X Appearance Published on: Mar 27, 2015 @ 10:02
[sbscrbr_forml o
£ Plugins
au Move toTrash Update
& T
Page Attributes
Settin, s
Parent
® BWS Plugins
" (no parent) J
Order
0
Word count 0 Last edited by admin on March 27, 2015 at 10:09 am Need help? Use the Help tabiin the upper

right of your screen

Featured Image

ured image
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9. A Wordpress Page with the Subscriber form in the frontend.

Example

() unsubscribe

SUBSCRIBE
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Subscriber
Installation Instruction

10. The second way. Add 'Subscriber Form Registration' widget, where your site
visitors can subscribe to your newsletters. Find the menu on your left and click
“Appearance” => "Widgets”

Pror New

Screen Options Help

@ Dashboard Dashboard
Welcome to WordPress! Dlsmiss
We've assembled some links to get you started
Get Started Next Steps More Actions
—————————— [ Write your first blog post Manage widgets or menus
Customize Your Site
+ Add an About page § Turn comments on or off

me completely B View your site & Learn more about getting started

Quick Draft

W 2Pages Title

r mind?
ing Twenty Fifteen theme.
Activity
Save Draft

RecentlyPublshed (et |

Some Post

NewWorld WordPress News

Ipsum Lorem

WordPress 4.2 Beta 3
Lorem ipsum o

4th, 8:40 am Hello worid! d

P
Comments ¢
N
From Mr WordPress on Hello world! # L

Hi, this is a comment. To delete acomment, just log in
and view the post's comments. There you will have WPTavern: Enhanced Plugin Installs Axed From

WordPress 4.2

WPTavern: WPWeekly Episode 185 - Turning The Page
With Joshua Strebel

All | Pending (0) = Approved = Spam(2) | Trash

Matt: Tokyo Meetup

Popular Flugin: WooCommerce - excelling eCommerce (Install)

11. Click "Subscriber Form Registration"
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Subscriber

A Promo

A ro

0 Media
| pag
L« ni

T
Custor
Widgets
Header
itor

£ Plugin
& Users
&
Setting!

A po

0 Media
| pag

L ni

M Appearance

h
Custor
Widgets
Header
itor
£ Pplugin:
& Users
& Tools
Setting!

Widgets manage in customizer

Available Widgets

Archives

Amonthly archive

Categories

Alist or dropdown of categories.

Meta
Login, RSS, & WordPress.org links.
Recent Comments

Your site's most recent comments.

RSS

Entries from any RSS or Atom feed.

our site's Posts

Subscriber Form Registation

Displaying the registration form for newsletter

subscribers.
Text
Arbitrary text or HTML

Inactive Widgets

s he

Thank you for crea

Widgets Manageincusto

Available Widgets

Subscriber Form Registation

Displaying the registration form for newsletter

subscribers.

Cancel

Thank you for creating

bar but keep the

WordPress.

WordPress.

Calendar

Acalendar of your site's Posts.

Custom Menu

Add a custom men to your sidebar.

Pages

Alistof your site's Pages.

Recent Posts

Your site’s most recent Posts,

Search

Asearch form for your site

Tag Cloud

Acloud of your most used tags.

bestwebsoft.com

support.bestwebsoft.com

Widget Area

search

Recent Posts

Recent Comments.

Archives

Categories

Pages

Widget Area

search

Recent Posts

Recent Comments.

Archives

Categories

Pages

inyour
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Subscriber
Installation Instruction

13. Fill in the Subscriber Form Registration and click "Save"

Subscriber Form Registation

Widget Title:

Text above the subscribe form:

Placeholder for text field:
E-mall

Label for "unsubscribe" checkbox:
unsubscribe

Label for "submit" button:

Subscribe

[ apply plugin settings

Delete | Close

14. The Subscriber Form in the sidebar of your site in the frontend
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Installation Instruction

RECENT POSTS
Some Post
New World

Ipsum Lorem

Lorem ipsum

Hello world!

E-mail

(0 unsubscribe

BSCRIBE

RECENT COMMENTS

Mr WordPress on Hello world!

ARCHIVES

March 2015
February 2015

December 2014

15. Go to “Users” => "Subscribers” in the menu on the left in your admin area

Screen Options

Dashboard
Home

Welcome to WordPress! Dismiss
‘We've assembled some links to get you started:

Media Get Started Next Steps More Actions
I Wwrite your first blog post Manage widgets or menus
Customize Your Site
+ Add an About page § Turn comments on or off

or, change your theme completely [ View your site = Learn more about getting started

. Quick Draft .

I 4pages Title

What's on your mind?
ing Twenty Fifteen theme.

Activity N
ve Draft
Recenty publshed [ sore0t |
Mar 6th, 10:04 am Some Post
Mar 6th, 10:04 am New World WordPress News -
Feb 121, 1247 pm {psum Lorem WordPress 4.2 Beta 3 March 26,2015
Feo 12, 1236 pm Loremm ipsum WordPress 4.2 Beta 3 is now avalable! This software s stil in
Dec 4th, 8:40 am Hello warld! development, so we don't recommend you run it on a
production site. Consider setting up a test site just to play with
Comments the new version. To test WordPress 4.2, try the WordPress Beta
Tester plugin (you'l want *bleeding edge nightlies"). Or you can
From MrWordPress on Hello world! # L1
Hi,this is a comment. To delete a comment, just log in
and view the post's comments. There you will have ... WPTavern: Enhanced Plugin Installs Axed From
WordPress 4.2
Al Pending (0) | Approved | Spam(2) | Trash( WPTavern: WPWeekly Episode 185 - Turning The Page

With Joshua Strebel

Matt: Tokyo Meetup

Popular Plugin: WooCommerce - excelling eCommerce (Install)
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Subscriber

16. Find the Subscriber menu. Here you can see the list of subscribed and
unsubscribed users, as well as the Black List and Trash.

@ rd Subscribers

All(2) | Subscribed (1) | Unsubscribed (1) | Black List(0) | Trash(0) | seard h

B Media Bulk Actions ~| | Apply

() Name E-malil Status

.
c

usersecondtwo@gmailcom Unsubscribed from
27 Mar 2015

User 1 userfirstone@gmail com Subscribed from
27 Mar 2015

TR

Name E-mail Status

Bulk Actions J Apply

B %

o G

for creating with WordPress Version 4.1.1

If you want to send mailout to the users who have subscribed to newsletters, please use
Sender plugin that sends mail to registered users. There is also a premium version of the
plugin - Sender Pro, which allows to create and save templates for letters, edit the content
of messages with a visual editor TinyMce, set priority of mailing, create and manage mailing
lists.
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Installation Instruction

This instruction can be applied mostly to Subscriber Pro, too

Help & Support

Visit our Help Center if you have any questions.

Our friendly Support Team is happy to help.

support.bestwebsoft.com

Need Website Development or Design Services?

We provide additional services such as Wordpress themes & plugins development, graphic design,
custom programming.

Contact us now to get a free quote — https://bestwebsoft.com/contacts/
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